FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

Status: Retired

GeneMarker Manual v 2.9

Document ID: 6311

DATE EFFECTIVE
08/31/2021

APPROVED BY
Nuclear DNA Technical Leader

PAGE
1 OF 38

1.1

1.2

1.3

1.4

2

2.1

2.2

GeneMarker v2.9.0 Manual

Guiding Principles and Scope

This method contains the steps for the analysis of PowerPlex Fusion and Yfiler STR runs from
the 3130 using GeneMarker HID v2.9.0.

For more information on the use of GeneMarker HID v2.9.0 see General Overview Section 19.

For first time GeneMarker use, for a new installation, or for new computer hardware see QC355-
GeneMarker setup.

This manual cannot cover all situations that could arisef/during the analysis of an STR run. If an
analyst encounters something that isn’t covered by this'manual, they should seek their supervisor
for further guidance.

Load Data

To start your project, go to File — Open Data —»Add

2.1.1 Navigate to the network folder containingthe data files (i.e. the .fsa files) to be analyzed.

2.1.2 Select files to add (ificlude only one ladder per project)

2.1.3 Hold Ctrl key#o,selectmultiple files

2.14 If analyzing all files'held €trl and A keys

2.1.5 Select Open

2.1.6 Ensure correct files are added to list

2.1.7 Ensure Auto-Elevate is not selected.

2.1.8 Select OK

Ensure that prefixes LD, PC and NC are labeling the allelic ladder, positive control and
negative control, respectively, in the Sample File Tree.

2.2.1 If they are not, right click on the sample name in the Sample File Tree — Set Sample Type
— Select appropriate sample type

222 Click Run Project located in the top toolbar.
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3 Run Wizard

3.1 In Template Selection window, select the appropriate existing template; Fusion (Evidence),
Fusion Exemplars, or Yfiler® (Evidence or Exemplars). If “Last Template” is displayed in
Template Name field, ensure that the appropriate Panel is listed for your analysis.

3.1.1 Note: Do NOT click Save on any of the following windows. This will overwrite the
template for all analysts.

3.2 Fusion (Evidence)

Template Mame: |Fusi|:|n

Panel: |Fusion_OCME_no fiter - | [ | 2
Size Standard:  [ILS500 jﬂu‘l I

Standard Color. | DR&NGE ~] |

3.2.1 Click Next

322 In the Data Process windew, ensure-the following settings are used:
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Run Wizard @1

Data Process - HID Analysis
Set data process options

Faw Data Analysiz
v Auto Range [frame)
O [10000 &
v Smooth [~ Enhanced Smooth

Bazeline Subtraction:

v Superior [~ Claszsic [ Enhanced

[~ Pullup Comection v Spike Removal

v Saturation Detection [ Saturation Repair

Size Call

(¢ Local Southern (" Cubic Spline

Allele Call
[ Auta Range [bps]
Stat (55 3] End [510 %]

[w Score Filker
Peak Detection Threshald: j

tin Intensity: |50 | Adan Intenzity: | 32760 5
Percentage » |0 =1 Globahk ax

Mote: Use PanélEditor to set Min Intersity

and % Glolal Max forpeaks withinMarkers

& seve | Back et | Caneel
323 Click Next
324 In the Additional Séttings window,jensure the following settings are used:

Run Wizard

WI .

Additional Settings = HIDd&nalysis

558

Set additional options related tothedifferent analysis type

LLICNE

v Auto Select Best Ladder

Pozitive Control Template: |PP_Fusi0n

Allele Evaluatior
Peak, Score:

Reject < {000 Check [1.00  <Pass

[ Mixture Evaluation
a
3

v Auto Panel Adiustrment

[ save |

<¢ Back LCancel
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33 Fusion Exemplars
Ternplate Name: [Fusion Exemplars
Panel: [Fusion_OCME_10% ;IH@
Size Standard: 15500 =1
Standard Color: | ORANGE |
3.3.1 Click Next
332 In the Data Process window, ensure the followi ings are us
Run Wizard =

Data Process - HID Analysis
Set data process options

— Raw Data Analysis
W Auta FBange [frame)

Stark; IEI 3.

[ Smoath

Stat |55 3] End 510 3
v Scare Filker
Peak Detection Threshald: _"I

in [ntensity: IED 3, I 3 | mtenzity: |32?ED 3,
Percentage » I'ID 3. Glabal tax

Mote: Use Panel Editor to set Min Intensity

and % Global Max for peaks within Markers

& save | Delete << Back T Hent sy Cancel
333 Click Next
334 In the Additional Settings window, ensure the following settings are used:
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Run Wizard M

Additional Settings - HID Analysis

Set additional optionz related to the different analyzis type

Aleliz Ladder  [NONE = [v Auta Select Best Ladder

Positive Contial Template: IPP_Fusion j V¥ Auto Panel Adjustment
aillele Evaluatiorn

Peak Score:
Reject < ID.DD Check. |1.UU < Pazs

1 Misture Evaluation

Walid Misture Peak Percentage: IEI b4
Mir Misture M arker Mumber: |3

& Save | Delste | << Back b G

34 Yfiler® (Evidence or Exemplars)
Template Mame: I"I"Filer
i

Panel: I\fﬁler_DCME

Size Standard: ILIE_‘\"ﬁIer

Standard Calor: IEIFH.-“-‘-. j

34.1 Click

342 In the Data Process window, ensure the following settings are used:
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Run Wizard @1

Data Process - HID Analysis
Set data process optiong

Fiaw Data Analyzis Allele Call
[ Auto Range [frame] [ Auto Range [bpsl

Stat [2300 3] End [3000 3] stat [75 3] End [0 3
v Srnoath [ Enhanced Smoath ¥ Scare Filker
Baseline Subtraction: Peak Detection Thieshald: 7 |
[ Superior [ Clazzic | Enhanced Wi [ntenzity: ﬂ hdax [nkenzity: m
W Pull-up Corection  [w Spike Removal Percentage > m Glokal M ax

v Saturation Detection [~ Saturation Fepair MNote: Use Pan@l Editar to s8thdin Intefisity

and % Global Max forfpeaks within harkers

Size Calt
(¢ Local Southem " Cubic Spline
& 5ave | << Back Cancel
343 Click Next
344 In the Additional Settings windowsy,ensure the following settings are used:

Run Wizard ‘ I @

Additional Settings - HID Analysis

Set additional options related tathe different analysis type

AE”- 'NONE J v Auko Select Best Ladder

Pasitivie, Contral Temnplate: |Yﬁler MPC ﬂ W Auto Panel Adiustment
Allele Exahuatior

Peak Score:

Reject < |0.00 Check [1.00 < Pass

[~ Mixture Evaluation

¢ Back | Ok | LCancel |

3.5 If NONE is listed under Positive control template, select the Positive Control Template using the
dropdown:
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3.6 For PowerPlex Fusion® (all templates) - PP_Fusion
3.7 For Yfiler® - Yfiler MPC
3.8 Note: Do NOT click Save within the Data Process Window. This will overwrite the template for
all analysts.
3.9 Click OK — Once data has finished processing Click OK
3.10  On the top left corner of the screen, Click File — Click Save Projeet=> Navigate to desired

4

4.1

4.2

4.3

folder and save project using the naming system based on the instrument, date, injection
number(s), kit and analysis set (i.e. Newton090615 8-11U A)

3.10.1  You must save over the existing project every time you save.

Checking the Size Standard

[

Located on the top toolbar in the main analysis windowsClick Size Calibration

In the Calibration Charts windowgClick Chart Synchronize ~

Click Sample Name header to sort samples in order. In the Sample List, either Click on a
Sample or Navigate using the Up/Down, Arrows, check the size standard for each sample and
control as per the amplificationekit.

4.3.1 PowerPlex Fusion®
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200

00

400

200
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4.3.2 Yfiler ®
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4,000

2,000
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4.3.3 If the peak is recognized by the software, a green inverted triangle appears at the top of the

peak. '

4.3.4 If a sample contains a size standard peak without a green triangle present the size standard
for that sample fails. Refer to STR Results Interpretation-PowerPlex Fusion & STRmixTM
manual.

4.4 Close Calibration Charts window.

4.4.1 If any sample or control is automatically marked as disabled by the'seftware, review the
size standard in the Calibration Charts window to ensurefthis was due to failing or poor size
standard. If it is confirmed that the sample has a failing or poor size standard, a rerun code
must be applied to that sample. Right click on thegample in SamplefFile Tree within Main

Analysis Window = Click Edit Comments -¢Enter reérun code in Comments field >
Click OK

4.4.2 In the Main Analysis window, Click en the Down Arrow next to the Show Color icon
located in the top toolbar. — Click Hide,All

443 In the Sample File Tree, Right Click.on Allele Call —Click Select Max

4.4.4 In the Main Analysis,window, Click on the Down Arrow next to the Show Color icon
located in the top teolbar. — ClickkORANGE

44.5 Note: The size 'standard can also be viewed in the Browse by All Color Window
4.5 Adjust axis tofview size standard depending on amplification kit

Y,

4.5.1 On the top toolbar, Click Set Axis icon
452 Click Fixed ‘X > — enter X axis range

) PowerPlex Fusion® = 55-510
) Yfiler® = 75-410

453 Click Set Axis again — Select Auto Fit Y
4.6 Review size fragments by ensuring that all required peaks are labeled within +/- 0.5bp of the

fragment size. See the Fusion Ladder, PE and SS appendix or for Yfiler, the References - Allelic
Ladders, Controls, and Size Standards documents.

4.6.1 If a peak is not labeled or not within +/-0.5bp, then the size standard fails. Refer to STR
Results Interpretation-PowerPlex Fusion & STRmixTM manual.
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4.7 If any sample with failing or poor size standard has peaks called, the peak labels of those peaks

4.8

5

5.1

5.2

53

54

6
6.1

6.2

6.3

will need to be deleted.

4.7.1 Open the Browse by All Color analysis window > navigate to the relevant sample(s) =
highlight all peaks in one dye by holding down Ctrl, left click and dragging around any
peaks present in that dye - click Delete to remove the peak labels—> repeat for each dye

For any sample with failing or poor size standard, right click on sample in Sample File Tree
within Main Analysis Window = Click Edit Comments—> Enter rerun code in Comments
field=>Click OK

Checking the Allelic Ladder

There are two areas in the Main Analysis window thatdndicate.if the'allelic ladder used for
analysis has passed.

5.1.1 In the Sample File Tree, a red questionanark next to the allelic ladder would indicate a
potentially failed ladder.

5.1.2 In the Project Summary, a laddérerror would indicate a potential failed ladder.

Right click in the Sample File Tuée = Click Select Max. Open the Browse by All Color Window
=3

icon &= Visually confirm,all expected alleles in the allelic ladder are present. Refer to the
Fusion Ladder, PE and S8 appendix or for, Yfiler, the References - Allelic Ladders, Controls, and
Size Standards documeénts.

If the ladder used for analysis failed, try another ladder present on the same analysis set if one is
available. Cliek File from the ménu bar = Click Open Data - Highlight the failed ladder from
the Data File List > Click Remove - Click Add... = Navigate to the .fsa files > Select a
different ladder for analysis'—> Click Open -> Click OK. Return to Load Data, Section 2.2 and
proceed.

If there are no other passing allelic ladders in the analysis set refer to Refer to STR Results
Interpretation-PowerPlex Fusion & STRmixTM manual.

Amplification positive control (Fusion/YFiler)
For any STR plate, there must be at least one amplification positive control present.

The amplification positive control may be run at a different dilution than the corresponding
samples and the amplification set can pass.

A positive control may be edited for amplification or electrophoresis artifacts including (but not
limited to) pull-up, stutter and elevated baseline.
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6.4 Visually confirm all the expected alleles in the positive control according to the amplification kit

used. Refer to the Fusion Ladder, PE and SS appendix or for Yfiler, the References - Allelic
Ladders, Controls, and Size Standards documents..

6.4.1 A positive control that does not generate a complete genotype or gives an incorrect
genotype will be indicated as failing. Refer to STR Results Interpretation-PowerPlex
Fusion & STRmixTM manual for re-testing strategies

7  Negative Controls (Fusion/YFiler)

7.1 Evaluate the extraction and/or amplification negative control for'expected results. If peaks
attributed to DNA are detected refer to STR Results Interpretation-PowerPlex Fusion &
STRmixTM manual.

7.2 Some artifacts can be edited in a negative control if they are by-products of the

STR/amplification process. These include artifacts suchias dye blobs, spikes, and primer front.
Only re-test if artifacts are so abundant that amplified, DNA might be masked.

73 If a negative control with no peaks present contains misshapen size standard peaks that are
correctly called, the control passes.

8 Analyzing Samples

8.1 Analysis of the data can be performed inthe Main Analysis window and/or the Browse by All
Color EZ window.

8.2 Adjust axis to view samplés depending on amplification kit
P
8.2.1 On thétop toolbar, Click Set Axis icon %
822 Click Fixed ‘X > — enter X axis range

e PowerPlex Fusion® = 60-510
e Yfiler® = 90-340

8.2.3 Click Set Axis again — Select Auto Fit Y
9 Editing a peak
9.1 If a labeled peak is determined to be an artifact, click on the Peak to Highlight — Right Click—

Click Edit Comments— Enter code ‘a’ for artifact (refer to the editing codes document) — Click
OK.
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9.1.1 To select multiple peaks for editing, Hold the Ctrl key + left mouse click — Drag the
mouse to highlight all consecutive peaks

9.2 Once the Edit is selected, highlight the peak and press Delete key to remove the label from the
peak.

9.2.1 Note: If a label has been removed from a peak and needs to be restored, Click on Peak to
Highlight — Right Click —Undelete. If an edit needs to be removed from a peak = right
click on peak = click edit comments = remove text from Comments: box so the text field
is blank < Click OK (the E will still be visible but the edit comment will be removed)

9.3 To check peak history = Right click on peak = Click view history

9.3.1 Any changes made to the peak will be listed in order from mostrecent down. Click on any
line to view specific change details in the Current/Old Values: window. Scroll all the way
to the right to view edit code applied to peak in Allele Comments column.

9.4 +/- one repeat stutter should not be manuallyfedited from evidence in Fusion. Stutter can be
edited from Fusion positive control samplés and exémplar, samples.

9.5 Note: Peaks will only be consideredistutter, by theysoftware if they are within the bin of the
stutter peak. If a peak is outside of the stutter bin of'the parent peak the software will not
automatically filter this out asstutter, even if 1sunder the stutter filter percentage for that location.

10 Over- Saturation
10.1 Check for saturation detection

10.1.1  In the Main Analysis Wifidow electropherogram a pink line will indicate the possible
satufation of peak. This indication will also be noted in the Peak Table as <SAT> for that
allele i theé Allele Comment field.

10.1.2  If an evidencersample has excessively saturated peaks (>10,000 RFU or split peaks) this
sample must be rerun at a dilution. All peak labels must be removed. Enter the appropriate
re-run code and dilution factor.

10.1.3  If an evidence sample has labeled peaks above 7,000 RFU, with minimal artifacts, editing
may be performed. If there are many instances of pull-up, pull-down, and/or elevated
baseline, the sample may be rerun at a dilution. All peak labels must be removed. Enter the
appropriate re-run code and dilution factor.

10.1.4  Exemplars or positive controls with saturated peaks may be interpreted if artifacts are easily
recognizable and can be edited. With the exception of Fusion Direct samples, exemplars
may be rerun at a dilution if needed.
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11 Scheduling Re-Runs

11.1  If a sample Failed (over saturation, bad size standard, no data, instrument issue, etc.) > Right
click on sample in Sample Tree within Main Analysis Window = Click Edit Comments -
Type Re-Run Code in the comment box = Click OK

11.1.1  Re-run codes cover the majority of, but not all, situations. If one does not exist which
specifically describes the issue, please enter a reason in LIMS as to why the sample failed
under the sample status column — ex. possible injection issue.

11.1.2  Fusion Direct plates should not be realiquoted. Fusion Dixéct samples must be reamplified,
reextracted, or recut if a rerun is necessary.

11.2  All peak labels must be removed from failed samples,

11.2.1  Open the Browse by All Color analysis window >mavigate t0 the relevant sample(s) >
highlight all peaks in one dye by holdingddown Ctrl, left click and dragging around any
peaks present in that dye - click Deléte to remove the peak labels—> repeat for each dye.

11.3  If sample did not fail but re-run is desifed,=> Right click on sample in Sample Tree within Main
Analysis Window = Click Edit Comments,=> Type Re-Run Code in the comment box = Click
OK

12 Exporting for LIMS (all systems and sample types)

12.1  Once the entire run has beenaeviewed, all edits have been made and labels have been removed
from all edited peaks, omthe top left corner of the screen, Click File — Click Save Project

12.2  You must saye over the existing project every time you save.

12.3  In the Main Analysis Window = Click the down arrow next to the Show All Color icon = Click
Show All to turn'on all colors before exporting.

12.4  In the report display section of the main analysis screen, click on the down arrow next to the Save

Report icon " . Ensure the “Save LIMS report” is selected.
12.5  Inthe LIMS report settings window that pops up, ensure the settings are as follows:

12.5.1  The Size Range will be the same as the X- axis range for analysis

e 90-340 for Yfiler
e 60-510 for Fusion/Fusion Exemplars
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LIMS Report Settings @
Dyes Optiong
¥ BLUE ¥ RED ¥ Size Rangelbps)
GCrEE . From |50 to {510
¥ YELLOW

[~ Abide By Panel

[ Grouped By Markers

[ Show File Mame
Columns...

[~ Show Sample Mame

W Show Deleted Peaks m [«

| Hide Extra Sample Mames [ Show Only Uncertain Alleles

[~ Exclude Report Header | Show Rejected Low Score dlleles

Ok Cahcel |

12.5.2 In Options, click on “Columns...”; use,the/Add/Remove buttons to ensure the Selected
Columns are present and listed in‘the order that follows:

Selected Columnz

Plate 1D

b arker

Dye

Size

allele

Allele Comments
Sample Commigfibs

Note: This is'crucial to proper LIMS importation.

12.5.3  Click OK; Click OK again in the Allele Report Settings window.

12.6  Save the file as type “Excel File (* xIsx;*.xIs)” under the appropriate run name (delete suffix
“ AlleleReport”).

12.7  Navigate to the data entry screen for the corresponding test batch in LIMS. Click Import
Instrument Data and import the excel file for the project.

12.7.1 Refer to the Test Batch Analysis, Review and Approval manual for importing instructions.

12.8  Fill out the data entry screen keeping in mind the following definitions:
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12.8.1  Loaded — the data from GeneMarker has been imported

12.8.2  Not loaded —the sample or control was not imported/loaded into GeneMarker
12.8.3  Pass — the control has passed

12.8.4  Fail — the control has not passed

12.8.5  No Data — the control has not been analyzed

12.8.6  Not Used — the control was not used in analysis of the STRérun, typically reserved for
additional allelic ladders

12.9  If a control needs to be rerun, a comment (reason as to why the sample, failed) and resolution
must be entered into the LIMS data entry screen.

13 Printing Initial Analysis Electropherograms (all system and sample types)

Note: If exporting a PDF of an electropherogram from a rumthat was analyzed in GeneMarker v
2.8.2, please refer to section 18.

13.1  In the Sample File Tree - right.elick - select Max.
13.1.1  Double-click to DESELECT thefailed samples that are scheduled for rerun due to “no or
poor size standard”.” The .pdf of eleetropherogram is not necessary since the sample status

is indicated on the rerundable.

13.1.2  Include allgsamples that failéd for reasons other than “no or poor size standard.” The .pdfs
of the electropherogramsiwith all peak labels removed must be included within the casefile.

13.2  Click View—=> Preferences = Others tab
13.2.1 Ensure box for “Enable Sample Grouping” is checked = Click OK

13.3  In Main Analysis Window click Project = Apply Sample Grouping (if grayed out return to step
13.1)

13.3.1  Click Group By Order on the bottom left
13.3.2  Change Group Size to 1
13.3.3  Click Match on the bottom right = Click OK
13.4  In the main analysis window = Click Set Axis 2 Click Fixed X axis. The Size Range will be

the same as the X- axis range for analysis:
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e 60-510 for Fusion
e 90-340 for Yfiler

13.5
13.6

13.6.1

13.6.1.1 Standard Tab:

Print Report

Click Set Axis again — Select Auto Fit Y 4

In Main Analysis window = Click Print Icon

" Use Last Template

& Select an Exizting Template or Create One Sl IAdvancedI Page I

Template Mame: IDCME Frint Template Frink Type
¢ Mommal

EQOCME Print Template

" Chart Oy, N

Sample
Al Samples

I~ MizDyes
v Hide Bins

Save | X Delete | &h 0k |

LCancel

Select OCME Print Template on left and ensure the settings match below:
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13.6.1.2 Advanced Tab:

Print Report

+ Select an Existing Template or Create One

Template Mame: IDCME Frint Template
EJOCME Print Template

™ Usze Last Template

Standard  Advanced | Page I

Header:

[~ Print Project Comments [~ Each Paos [ WWord Wiap

[+ Print Report Headsr ¥ Each Page

I~ Label Dyes & Peak Numbers W File Mame [~ Sample Mame
Marker: Allele:

W Print Markers W Print Alleles
[~ Ahide by Panel

W Auto Scals Markers
Other:

[T Grouped by Dye

v Mew Page for Each Sample
v Implement % Axis Setings

¥ Prinit S amples Wit

13.6.1.3 Page Tab

Print Report

EROCME Print Templat

7 Use Last Template

— Paper
Size Type: I Letter LI
“width [mm): |21 59 Height (rmm): |2?9.4
— Margin [mm) Orientation
Left: [120 Right: [12.0 & Portrait
Top: |13.D Bottom: |1 30 " Landscape

Lancel |

& Save | X Delete | =113 |

13.6.2

Click Preview = Click Export to File icon ® Assure settings match below:
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Export Report to Files @
Export Farmat: | POF file j

File Maming tethod
(o Mamed by sample name
[~ Start by Page Mumber
" Mamed by file name
o

" Mamed by page number

W Save Group Samples as One File

13.6.3  Click on the “...” icon to choose the appropriate expoft directosy for the PDF files
13.6.4  Click OK - Export Report to PDFs Eyvents window willéappear. Once completed click OK

13.7  If analyzing Fusion Evidence: Wait to smport PDFs into LIMS until after the completion of
STRmix analysis, section 15.

13.8  If analyzing Exemplars or Yfiler Evidence: Import all PDFs into LIMS.

14 Fusion Exemplars Only - Exporting EXEMPLAR table for STRmixTM
input (for evidenge table instructions see Section17)

14.1  In Main Analysis Window Click the e icon = Select Show All In the report display section

i
of the main analysis screeny click on the report settings icon . Make sure settings match
below:
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[v Show File Name

~Orientation

[~ Show Sample Name

" Horizontal (¢ VYertical

[~ Exclude Sample Index
[~ Exclude Report Header

[~ Show Area
[~ Show Score

' [T Show |** WhenNo
| ™ Show Only Ung

14.2  Click OK => In the

. Ensure the “Save Report™ is selected.
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[ Allele Report Settings
~Report Style ~Options
" Allele List |v Extend Diploid Homozygous
@ Forensics ™ Splt ltems
" Bin Table [V Show Allele Name
" Peak Table [v Show Size (0.1bps)
" Allele Count v Show Height

tion of the main analysis screen, click on the down arrow

14.3  Navigate to appropriate folder and save file as an excel file (*.xlsx;* xls)’named as “Run

name SM”

14.4  For proper STRmix™ import the GeneMarker® to STRmix™ macro needs to be run.

14.4.1  Open the exported project excel file from Step 14.3 above.

1442  Open GeneMarker® to STRmix™ macro.

14.4.3 Follow the instructions on the “instructions” tab.

14.5  After macro has run click “save as” within the GeneMarker® to STRmix™ macro file.

14.6  Change the file type to “.txt” (text, tab delimited)
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14.7  Navigate to folder containing your project data and save file there.

15 Fusion Evidence Only - STRmix™ Analysis (stutter filters off)

15.1  Begin by importing the data from the initial analysis into LIMS to generate the edit sheet. Have

the edit sheet open in LIMS as you perform the second analysis with stutter filters off for
STRmix™ to refer to and ensure the same edits are being made the second time.

15.1.1  If Project is still open = Click Run Project -~ located in the.top toolbar.

15.1.2  Ifproject is not open > Click File = Open Project > Nayigate to run, - select project >

click open > Click Run Project - located in thedop toolbar.

15.2  In Template Selection window, select the appropriatéexisting template.

Run Wizard

Template Selection l

Set the template of the project

& Select an existing template or create one

A Fusion Tenfplate Name: [Fusion_STRmix

gusors Fanet |Fusion_OCME_STRmix_Nol_» | |1| | =

4 YFiler Sie Standatth, fsso0 -] W
Standard Color: lDF\ANGE -

™ Use last templaté

& Save 2 Delete | Hext > | LCancel

15.3  Click Next
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15.4  Inthe Data Process window, ensure the following settings are used:
Run Wizard @
Data Process - HID Analysis
Set data process oplions
Raw D ata Analysiz Allele Call
[v Auto Range [frame] [~ Auto Range [bps)
o3 10000 3] Stat [55 2] End [510 2
[v Smooth [~ Enhanced Smoath ¥ ScomiFie
Baseline Subtraction: Peak Detection Threshald: j
Iv Superior [~ Clazsic [ Enhanced Min Intengity: |50 | Maxlntensity: | 32760 .3
[ Pullup Corection  [w Spike Femoval Percentage » |0 vi Global tdax
¥ Saturation Detection [ Saturation Repair Mote: Use Panél Editar to set Mirrntensitd
) and % GlolalMax for péaks within Markers
Size Call
f* Local Southern ™ Cubic Spline
& Save | | << Back | Cancel
15.5  Click Next
15.6  In the Additional Settings window, ensure the following settings are used:
il v =)
Additional Settings - HID Analysis
| Set additional optionzselated ta the different analyzis type
Al NenE = W Ao Select Best Ladder
Puositive Contral Template: |PP_Fusi0n j W Auto Panel Adiustment
Allele Evaluation
’ Peak Score:
Reject ¢ |0.00 Check (1.00 < Pazz
[~ Mixture Evaluation
0
3
& Save | | << Back Cancel |
15.6.1  Note: Do NOT click Save within the Data Process Window. This will overwrite the

template for all analysts.
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15.7  Click OK - A window will pop up:

Use Old Calibration =

& Size Calibration

The internal lane sizes hawe been calibrated in the samples.
“'ou may check Call Size Again to recall the sizes.

What to do:

Apply bo Al | Apply to Current

15.7.1  Check “Call size again” and Click Apply to Allh-> Allew.data to process = Click OK

15.8  On the top left corner of the screen, Click Filey> €lick Save Project = Save Project with suffix
SM

15.9  Perform a second analysis of this run

15.9.1 Do not recheck or edit Ladder, Size Standard or Controls. Passing controls and size
standard are detesmined by the initial analysis. Leave all controls and failed samples
ENABLED

15.9.2  Removethelabels from the' same peaks that were edited in the initial analysis. It is not
necessary to enter edit.codes again.

15.9.2.1 Ifanartifact (excluding stutter) was previously filtered out in the original analysis (ex. a
pull-up that was adjacent to a stutter bin) but is present in the STRmix analysis, the label
must be removed from this analysis set. This edit must be recorded directly into the LIMS
data entry screen.

15.9.3  If a sample had a rerun code during the initial analysis it is NOT necessary to enter the
rerun code again.

15.10 Once the entire run has been reviewed, and labels have been removed from all artifact peaks,
Click File — Click Save Project

Controlled versions of Department of Forensic Biology Manuals only exist in the Forensic Biology
Qualtrax software. All printed versions are non-controlled copies.
© NYC OFFICE OF CHIEF MEDICAL EXAMINER Qualtrax template 072220



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

Status: Retired

GeneMarker Manual v 2.9

Document ID: 6311

DATE EFFECTIVE
08/31/2021

APPROVED BY
Nuclear DNA Technical Leader

PAGE
22 OF 38

16 Fusion Evidence Only - Printing Electropherograms after STRmix™
Analysis (evidence samples only)

Note: If printing or exporting a PDF of an electropherogram from a run that was analyzed in
GeneMarker v 2.8.2, please refer to section 18

16.1  In Sample File Tree - right click 2 Select Max

16.2  Double click on sample to DESELECT:

e All Controls (Ladder, PC, NC, Eneg, Mneg)
¢ Any failed sample

16.3  Click View=> Preferences = Others tab

16.4  Ensure the box for “Enable Sample Grouping” is.checked= ClickdOK

16.5 In Main Analysis Window click Project 2 Apply Sample Grouping (if grayed out return to step

16.1)

16.6  Click Group By Order on the bottor left

16.7  Change Group Size to 1

16.8  Click Match on the bottom right 2 Click OK

16.9  In the main analysis window - Click Set Axis = Click Fixed X axis The Size Range will be
the same as theX="axis range for@nalysis:

e < 60-510/for-Fusion

16.10 Click Set Axis again — Select Auto Fit Y

16.11 In Main Analysis window = Click Print Icon

16.12 Select OCME Print Template on left

16.13  Ensure the settings match below:

16.13.1 Standard Tab:
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Print Report [=E3m)
% Select an Existing Template or Create One Sl IAdvancedI Page I
Template Mame: IDCME Frint Template ’7 Prit Type
* Momal = Chart Overlay
E)OCME Print Template .
ample: [iye
Al Samples ¥ BLUE ¥ RED
* Selected Samples v GREEN [ DRANGE
¥ YELLOW
Content:
[V Electropherogram [ ix Dyes

 Usze Last Template

PeakT able
% Follow Trace Chart
£ Start after &1 Charts Finished

¥ Hide Bins

€ Start on Separate Page

[” Forenzics Table

16.13.2 Advanced Tab:

Print Report

* Select an Existing Template or Create O

Template Mame:

EROCME Print Template

" |ze Last Template

I~ EachPage [© ‘WoaodWiap

¥ Frint Report Header ¥ Each Page

abel Dyes & Peak Numbers [V File Name [~ Sample Narme
Allele:

W Pritit Markers [ Print Alleles
[~ Abide by Panel

¥ Auto Scale Markers
Other:

I~ Grouped by Dpe

I~ Frirt Edited Peak Orily
¥ tark Deleted/E dited Peaks

Label Peak Ratio
% Label Peak Height Fatic
" Label Peak Area R atio

¥ Mew Page for Each Sample

¥ Implement ' Axis Settings

v Frint 5 amples With Grouping — Chart Height [ ISS =l

n Save | x Delete | @ Ok |

LCancel |
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16.13.3 Page Tab

Print Report (==

* Select an Existing Template or Create One 'Slandard | Advanced Page

Template Mame: IDCME Frint Template
EJOCME Print Template

— Paper

Size Type: I Letter

width [mm):  |215.9 Height [rorm]:

— Margin [mm)
Left: [12.0 Right: [12.0
Top 130 Battom: [13.0
 lse Last Template
@ |

Elpoﬂlhpoﬂtoﬁesﬁ ‘

Expodt Format | POF file

File Naming Method

WV Save Group Samples as One Fie

16.15 Click on the “...” icon to choose the appropriate export directory for the PDF files

16.16 Click OK - Export Report to PDFs Events window will appear. Once completed click OK

16.17 Import all PDFs (initial Fusion analysis and STRmix analysis) at the same time into LIMS.
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17 Fusion Evidence Only - Exporting EVIDENCE table for STRmix™ input

17.1  In the report display section of the main analysis screen, click on the report settings icon .
Make sure settings match below:

Allele Report Settings @\
Report Siyle Options
" Allele List [v Estend Diploid Homozygous
(* Forensics I~ Bpltltems
" Bin Table [v Show Allele Mame
" Peak Table [v Show Size (0.1bps)
" Allele Count v Show Height
| Show Area
v Show File Name [ Show Score

Show Sample N
M) Sz A ™ Show [ When No Allee Call

Orientation [~ Show Orly Uncertain Alléles
" Hotizontal & Vertical
[v Show Rejected Low Scomédllsles
[~ Exclude Sample Index [~ Hide Extra Sample ames

[~ Exclude Report Header [~ Show Selected Samples

o | Eancel

172  Click OK

17.3  In the report display sectionof the main analysis screen, click on the arrow of the Save Report

icon = - . Glick“Save Repont”

17.4  Navigate toappropriaterfelder and save file as “Excel File (*.xlsx;* xIs)” named as “Run
name SM”

17.5  For proper STRmix™ import the GeneMarker® to STRmix™ macro needs to be run.

17.5.1

17.5.2

17.5.3

17.5.4

17.5.5

17.5.6

Open the exported project excel file from Step 17.4 above.

Open GeneMarker® to STRmixTM macro.

Follow the instructions on the “instructions” tab.
After macro has run click “save as” within the GeneMarker® to STRmix™ macro file.
Change the file type to “.txt” (Text, tab delimited)

Navigate to folder containing your project data and save file there.
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18 Re-printing/exporting a PDF for a sample from a run that was analyzed
in GeneMarker v 2.8.2

18.1  In the main analysis window,
18.1.1  Click Set Axis - Click Fixed X axis
18.1.2  The Size Range will be the same as the X- axis range for analysis:

e 60-510 for Fusion
e 90-340 for Yfiler

18.1.3 Select Auto Fit Y

18.2  Click Tools=> Export Electropherogram

18.3  Set Output Folder to desired location for projéct PDFs by clicking g icon

o 7 : el

Output Folder: |M:'\STH_Data\Qﬂ_QE'\.&thena'\Em BhAthena031416_10-11_2016-09-14% J

Export Electropherograms

18.4  Ensure settings match below:

18.4.1  Make sure to select PDF as export format

Select Dyes

v BLUE

v GREENM

| YELLOW

v RED
ORANGE

Dye Image Size

Width: | 1024 pinelz

Height: |700 pixelz

[~ Oreimage per zample
v Auto Scale Size Range
[ duta Scale Marker Intensity

Expart Format: |PDF file
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18.4.2  For exemplar or non-SM analysis: In the suffix field enter the run name with a “ ” before
it. (Ex: _Newton061316 88-89U A)

18.4.3  For SM analysis: In the suffix field enter the run name with a “ ” before it followed by
_SM (Ex: _Newton061316 88-89U A_SM) to indicate STRmix™ analysis.

18.5  Printing the ladder: Right click in the sample list = click Deselect All & Check the box for the
ladder = In prefix field enter ladders_ = click Export

18.6  Printing the controls: Uncheck the box for the ladder and check theboexafor all controls in the run
-> In the prefix field enter controls_ - click Export

18.7  Printing the samples: Right click in the sample list = clickfSelect All = Uncheck the box for all
ladders and controls in the run, leaving all samples seleeted = clearthe prefix field = click
Export. This will create 4 PDFs for every sample, on€ for each dye.

18.8  Import all PDFs (initial Fusion analysis and STRmixyanalysis, as@pplicable) at the same time into

LIMS.

19 General Overview

19.1  Main Analysis Window

19.1.1  There are four majorisplays in the main analysis window.

1 Navigator; Sample File Tree
2 Electropherograms

3 Report; Report Table

4 Projeet Summary

19.1.2 See HERPEUL ICONS INDEX for further details.
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19.2  Navigator;

NC geroe 070 Ladckraroe 43 | SFailed=7 [ =ragges=sz
— =]

19.2.1  This viewdists all the samples that are included in the project. Prefixes LD, PC and NC are

19.2.2  The sheet icon to the left of the sample name indicated the quality of the internal lane

standard (ILS) with the following color/code:

allelic ladder, positive control and negative control

e Green = High Lane Quality; Passing Size Standard B

e Yellow

= Requires Verification B

e Red strike through = No Sizing Occurrence; failed to call size O

e Red Question Mark = one or more quality criteria are not met based on the

analysis parameters; See Quality Reasons Index for more details.
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19.3  Project Summary

19.3.1  This bar located at the bottom of the main analysis screen summarizes the project as well as
alerts the analyst to samples that did not pass analysis parameters.

MNew 22 samples PCerror: 1/1 MNC error: 3/3 Ladder error: 0/1 #Failed=1

e New reflects the data set is not a project that has been previously analyzed.

o Ifthe first column reads Modified, the project was previously analyzed in the
software.

e The second column denotes the number of samples (ineluding controls) contained in
the data set.

e Columns 3-5 indicate the number of controls,in‘the dataset that do not meet the
quality criteria set in the softwarex

e Column 6 denotes the number‘of samplésithat were disabled.

e Column 7 denotes the oyeralbnumber, of samples, except the allelic ladder, that do

not meet the quality criteria set mithe software.

19.3.2  Note: Flagging featires are an indication of potential failures. The ultimate decision of
passing/failure isdmade by the analyst after further evaluation.

19.4  Calibration Chart Window:
19.4.1  Theredare three major displays in the calibration chart window.

1 Sample Kist
2 Size Standaxd Template
3 Sample ILS
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19.5  Sample Lis

19.5.1  This vi ts all the samples that were processed in the project. The Score column

w well the size standard template and the sample ILS match. The closer the
score is to 100, the better the match. The sample may fail automatically if the size standard
is bad enough or may have to be failed manually by the analyst.

-

19.6  Size Standard Template

19.6.1  The template highlights all the peaks that should be labeled in the corresponding sample
ILS for easier comparison.

19.7  Samples ILS

19.7.1  The sample ILS displays the peaks that were detected. As well as the approximate start of
the data analysis view, indicated by the dash line.
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19.8  Browse by All Color Window

19.8.1  There are four features in the Browse by All Color that allow for straightforward review of

the sample.

1 Sample Drop-Down
2 Max Chart Number
3 Scroll Within a Sample
4 Scroll Between Samples
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19.9  Sample Drop-Down

19.9.1  The sample drop-down lists all the samples within a project. A user can move between
samples by clicking on the sample name instead of scrolling through all electropherograms.

7

19.9.2 NOTE: Analysts can zoom in/out by using the zoom icons e located at the top
toolbar. As an additional option, hold down the left button on the mouse and drag the
dotted box that appears from the upper left to the lower right (around the desired “zoom in”
area). To zoom out, hold down the left button on the mouse agaimidragging box from lower
right to upper left. To scroll while zoomed in, right click and hold while dragging the
mouse in the direction you want to scroll.

19.10 Max Chart Number

19.10.1 Max chart number views each sample by the numberf dye lanes as per the user’s needs
during sample analysis.

19.11 Allele Labels

19.11.1 When analyzing samples in the, Main Analysis window or the Browse by All Color
window, alleles may be colered yellowhor red.

| THO1 | | @13s317 Y Di6ss3s | | D251338 |
160 180 200 4220 240 @80 280 300 320 340 380

NIRRT

T i ] 145

14510 2166 2651 31949

3316 (A ] 5106 5842
g 11 11 21
1629 225.5 2762 3323
3396 7503 Ve 4 G007

19.11.2 This indicates that one or more quality criteria have not been met in the software. See
Quality Reasons Index for more details.

19.11.3 Note: Flagging features are an indication of potential artifacts and/or allelic imbalance, or
peak saturation. The ultimate decision of passing/failure is made by the analyst after further
evaluation.

19.12 Peak Table
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19.12.1 When analyzing samples in the Main Analysis window or the Browse by All
Color window, a peak table maybe added to supplement analysis by clicking Show Chart/Table

icon
] 1 o |
| DEs1173 | | 021511 | [ D7sszo | [ csFipo |
100 150 200 250 300 350
LELELEL LI
1,200
1,100 I
1,000
900
500
7004 ||
600
500
400
300
2001
100
D.\—h__m Y Jwl
-1 DD E T Il 117
[11,274.89.456] [12,329:3,702]
Mo, | Dye Size m Marker ‘ Guality Score | Allele Comments Guality Rea...
1 Ble w7 A7 9%.7 Undeter... 1.3 oL
2 Bue 1437153 ADasnra, 13 Pass 1217
3 Ble 2078 828 0215137 30 Pass 100.6
4 Ble @708 6210, D750 10 Pass 461
5 Bled 2749 455 075820 11 Pass 271
E  Bue 3211 1184 ECSFIPO 10 Pass 971
7 Blue, 3233 702 C5F1PO 12 Pass 465

19.12.2 This table will indicate to an analyst which alleles were flagged and which quality reason
was triggered. See PEAK TABLE OPTIONS INDEX for further details.
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20 HELPFUL ICONS INDEX
20.1  Main Toolbar Icons
Icon Name Function
Run Project | Opens Run Wizard for processing the data.
| 4
Show/Hide | Allows user to show/hide the frames for the Sample File Tree,
7 B W Toggles Synthetic Gel Image and Report Table, respectively.
Allows user the choice of viewing/hiding all color lanes or
Show Color | single dyelane layer (with single left mouse click on the icon,
H
v obtain single:dye view)
Allows for more discriminate view of electropherogram.
Alternately, hold down left mouse button and draw a box;
Zoom/Zoo . . .
m Ofit dragging from top left corner to bottom right zooms in on
image while dragging from bottom right corner to top left
e Q image while dragging from b igh lef
zooms out.
Default sets Y-axis by maximum peak intensity for the
Set Axis sample displayed. The other 2 options either auto-fit the Y-
% axis by the peak intensity of the alleles displayed, or allow for
setting the X- and Y- axes ranges manually.
Allows for comparative view display of sample
Browse . .
electropherograms by dye color. Individual samples can be
by All . .
g Colors selected from the drop down menu in the upper right corner
il of the All Color Browser display window.
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20.2  Allele Call Icons available after raw data processing only; Sample File Tree Allele Call folder must

be selected

Icon Name Function
A Size . . . . . .
Calibration Displays calibration charts for linearity of lane analysis.
Show Allows user to togglethe display to show only the Peak Table,
7= the Peak Table and the Electropherogram, or just the

Chart/Table

Electropherogram.
. Allows user to export the Peak Table as an Excel(.xls) file or a
Save Peak Table | 0 qelimitéd Text (.txt) file.
Allows user to call alleles by sample(s), by marker or by dyes.
Allows user to make some modifications to the threshold/filter
N - Call All¢le settings without having to activate Run Wizard again (i.e. Peak

Detection Threshold, Stutter Peak Filter and Peak Score
Threshold).

Marker

Maer [Nong- v Drop- Allows user to select a marker to view. Available after the

down samples have been compared to a Panel.

Menu

Event Log Displays the processing success/failure of each dye lane.

a3l Magic Activates the Start Your Project, Run and/or Report dialog
- Wizard boxes.
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20.3  Browse By All Colors Icons
Icon | Name Function
G)\ e\ Zoom In/ Same use as in the Main Analysis Screen.
Zoom Out
Show/Hide Allows user the option to show/hide X- and Y- axis grid

Mouse Cross
Lines

lines that appear,at the tip of the mouse cursor along with
the basepair'size and RFU yalue of the mouse cursor
position,

A Show/Hide Allows user the option to show/hide the Bin brackets at
- Bin Ranges the top and bottom of the electropherogram.

Allows user the option to adjust the RFU intensities of

lﬁs Auto.Seale low peaks to match the 1ntens1ty. of the hlghest'peak in the

Matkers dye color. When low peaks are increased, the intensity

magnification factor is noted in the marker (can adjust
from 2X to 8X).

= Print Opens the Print Report settings box. Also accessible in the

Main Analysis screen.
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20.4  Report Table Icons located directly above the Report Table.

Icon | Name Description
Report Allows user to customize Report Table display
| — | Settings settings.
=] Save Allows user to export.the Report Table as an Excel
_— Report (.xIs) file ox‘tab-delimited Text (.txt) file.
Sustomlz Allows user to select which bins to include/exclude
Bin in the ReportTable (check with TSL as this is
not accessible at this time)
Column
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21 PEAK TABLE OPTIONS INDEX

Dye dye lane location of peak
Size peak basepair size (x-axis)
Height value given as relative frequency units (RFU) of the peak (y-axis)
Height peak height divided by height of highest peak in the dye lane or
Ratio Marker
indicates the area under the curve of the peak; calculated based
Area . .
on x-axis Start/End column settings
Area peak area divided by area of highest peak in the,dye lane or
Ratio Marker
Marker locus location of the peak
bin location of the peak (based on kit/system paneland ladder
Allele . .
analysis of project)
. absolute value of distance between the peak center and Bin center
Difference | . .
in basepairs
assigns Pass/Check/Undetermined quality ranking for each peak
Quality relative to the Allele Evaluation Peak Score settings in the Run
Wizard (see Additional Settings)
an exponential curve based evaluation of the peak; calculation of
Score the value is based on signal-to-noise ratio and peak shape (or
morphology)
Start/End | beginning anddinish basepairs of the peak's Area calculation
Allele software and user edited comment.s for the peak; right mouse
Comments click peak in'chart to add peak edit comments or select from the
drop down list (more in Edit Comments Index)
user' added,comments for the sample; right mouse click sample
Sample . .
Comments | M2me in the sample tree to add new sample edit comments or
select from the drop down list (more in Sample Comments Index)
Quality letter code abbreviation(s) of reason(s) for a peak 's Quality
Reasons assignment if ranked Check/Undetermined
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